External Oscilloscope
Time Correlation and
Data Display

Online Help
Notices

© Agilent Technologies, Inc. 2001-2009

No part of this manual may be reproduced in any form or by any means (including electronic storage and retrieval or translation into a foreign language) without prior agreement and written consent from Agilent Technologies, Inc. as governed by United States and international copyright laws.

Manual Part Number
Version 03.82.0000

Edition
April 10, 2009

Available in electronic format only
Agilent Technologies, Inc.
1900 Garden of the Gods Road
Colorado Springs, CO 80907 USA

Warranty
The material contained in this document is provided “as is,” and is subject to being changed, without notice, in future editions. Further, to the maximum extent permitted by applicable law, Agilent disclaims all warranties, either express or implied, with regard to this manual and any information contained herein, including but not limited to the implied warranties of merchantability and fitness for a particular purpose. Agilent shall not be liable for errors or for incidental or consequential damages in connection with the furnishing, use, or performance of this document or of any information contained herein. Should Agilent and the user have a separate written agreement with warranty terms covering the material in this document that conflict with these terms, the warranty terms in the separate agreement shall control.

Technology Licenses
The hardware and/or software described in this document are furnished under a license and may be used or copied only in accordance with the terms of such license.

Restricted Rights Legend
If software is for use in the performance of a U.S. Government prime contract or sub-contract, Software is delivered and licensed as “Commercial computer software” as defined in DFAR 252.227-7014 (June 1995), or as a “commercial item” as defined in FAR 2.101(a) or as “Restricted computer software” as defined in FAR 52.227-19 (June 1987) or any equivalent agency regulation or contract clause. Use, duplication or disclosure of Software is subject to Agilent Technologies’ standard commercial license terms, and non-DOD Departments and Agencies of the U.S. Government will receive no greater than Restricted Rights as defined in FAR 52.227-19(c)(1-2) (June 1987). U.S. Government users will receive no greater than Limited Rights as defined in FAR 52.227-14 (June 1987) or DFAR 252.227-7015 (b)(2) (November 1995), as applicable in any technical data.

Safety Notices

CAUTION
A CAUTION notice denotes a hazard. It calls attention to an operating procedure, practice, or the like that, if not correctly performed or adhered to, could result in damage to the product or loss of important data. Do not proceed beyond a CAUTION notice until the indicated conditions are fully understood and met.

WARNING
A WARNING notice denotes a hazard. It calls attention to an operating procedure, practice, or the like that, if not correctly performed or adhered to, could result in personal injury or death. Do not proceed beyond a WARNING notice until the indicated conditions are fully understood and met.

Trademarks
Microsoft®, MS-DOS®, Windows®, Windows 2000®, and Windows XP® are U.S. registered trademarks of Microsoft Corporation.
Adobe®, Acrobat®, and the Acrobat Logo® are trademarks of Adobe Systems Incorporated.
External Oscilloscope Time Correlation and Data Display—At a Glance

The Add External Oscilloscope wizard automates and simplifies the process of setting up an external oscilloscope and a logic analyzer to cross-trigger and make time-correlated measurements (using markers). You can also display data captured by the oscilloscope in the logic analyzer's display windows. This external oscilloscope correlation and data display feature is sometimes called View Scope.

External oscilloscope correlation works with the following oscilloscopes, set up for remote control via LAN:

• Agilent InfiniiVision 5000 Series oscilloscopes.
• Agilent InfiniiVision 6000 Series oscilloscopes.
• Agilent InfiniiVision 7000 Series oscilloscopes.
• Agilent Infiniium 548xx Series oscilloscopes.
• Agilent Infiniium DSO/MSO8000 Series oscilloscopes.
• Agilent Infiniium DSO80000 Series oscilloscopes.
• Agilent Infiniium DSO90000 Series oscilloscopes.

The Add External Oscilloscope wizard can provide default (typical) deskew values for the type of logic analyzer and oscilloscope being used. You can also use the E5850A time correlation fixture to run a calibration procedure that provides the most accurate deskew values for the actual instruments being used. For more information about obtaining the E5850A time correlation fixture, contact your nearest Agilent Technologies Sales Office.

The instructions on the E5850A time correlation fixture box are for 16700-series logic analysis systems only. For 16900-series logic analysis systems or 1680/90-series logic analyzers, follow the instructions in this online help.

In This Book

• Getting Started with External Oscilloscope Time Correlation and Data Display (see page 9)
• Step 1. Network the oscilloscope and logic analyzer (see page 10)
• Step 2. Run the Add External Oscilloscope wizard (see page 13)
• Step 3. Make a measurement (see page 16)
• Working with Markers (see page 17)
• Displaying Imported Oscilloscope Data (see page 19)
• Controlling the External Oscilloscope via the Web (see page 23)
• Loading and Saving Configurations (see page 27)
• Changing External Oscilloscope Setup Options (see page 29)
• Deleting the External Oscilloscope (see page 31)
• Troubleshooting (see page 33)
  • Finding the External Oscilloscope IP Address (see page 34)
  • LAN Problems (see page 35)
  • General Triggering Problems (see page 36)
  • Unexpected or Inconsistent Results (see page 38)
  • Correlation Drift Over Long Acquisitions (see page 39)
• Reference (see page 41)
  • External Oscilloscope Setup Dialog (see page 42)
• Concepts (see page 47)
  • Trigger Deskew (see page 48)
  • How the Calibration Procedure Works (see page 49)
  • Uncertainty (see page 52)
  • What Do the Skew Numbers Mean? (see page 53)
• External Oscilloscope Module Control, COM Automation (see page 55)
• External Oscilloscope Module Setup, XML Format (see page 57)
Contents

External Oscilloscope Time Correlation and Data Display—At a Glance 3

1 Getting Started with External Oscilloscope Time Correlation and Data Display

Step 1. Network the oscilloscope and logic analyzer 10
Using a Point-to-Point Network 10

Step 2. Run the Add External Oscilloscope wizard 13
Additional Connection Information 13

Step 3. Make a measurement 16

2 Working with Markers

3 Displaying Imported Oscilloscope Data

4 Controlling the External Oscilloscope via the Web

5 Loading and Saving Configurations

6 Changing External Oscilloscope Setup Options

7 Deleting the External Oscilloscope

8 External Oscilloscope Troubleshooting

Finding the External Oscilloscope IP Address 34
LAN Problems 35
General Triggering Problems 36
Unexpected or Inconsistent Results 38
Correlation Drift Over Long Acquisitions 39

9 External Oscilloscope Reference

External Oscilloscope Setup Dialog 42
Channels Tab 42
Trigger Tab 43
Connection Tab 44
10 External Oscilloscope Concepts

- Trigger Deskew 48
- How the Calibration Procedure Works 49
- Uncertainty 52
- What Do the Skew Numbers Mean? 53

11 External Oscilloscope Module Control, COM Automation

12 External Oscilloscope Module Setup, XML Format

- <AnalogDataSource> Element 59
- <BusSignal> Element 60
- <BusSignals> Element 61
- <BusSignalSetup> Element 62
- <Channel1/2/3/4> Element 63
- <Channel1/2/3/4DataTable> Element 65
- <Channels> Element 66
- <ChannelsSetup> Element 67
- <ConnectionSetup> Element 68
- <Data> Element 69
- <DigitalChannels> Element 71
- <DigitalChannelsDataTable> Element 72
- <DigitalDataSource> Element 73
- <Folder> Element 74
- <Markers> Element 75
- <Name> Element 76
- <Names> Element 77
- <Pod1/2> Element 78
- <Programming> Element 79
- <SampleNumberDataSource> Element 81
- <SetupInfo> Element (for AnalogDataSource) 82
- <SetupInfo> Element (for DigitalDataSource) 83
- <SetupInfo> Element (for SampleNumberDataSource) 84
1

Getting Started with External Oscilloscope Time Correlation and Data Display

Software for external oscilloscope time correlation and data display is built-in to the Agilent Logic Analyzer application.

After the external oscilloscope and logic analyzer are networked, the Add External Oscilloscope wizard takes you through the process of connecting the logic analyzer to the oscilloscope. Once that is done, you are ready to make a measurement.

- Step 1. Network the oscilloscope and logic analyzer (see page 10)
- Step 2. Run the Add External Oscilloscope wizard (see page 13)
- Step 3. Make a measurement (see page 16)
Step 1. Network the oscilloscope and logic analyzer

If your logic analyzer and external oscilloscope are both already connected to a LAN, you can skip this step.

When using a 6000-series oscilloscope, the LAN port must be selected as the I/O Controller. (Press the Utility button; then, press the I/O softkey; use the Entry knob to select LAN; then, press the Controller softkey.)

If your logic analyzer and external oscilloscope are not already connected to a LAN, a simple point-to-point connection may be the most convenient connection between the instruments (see Using a Point-to-Point Network (see page 10)).

If you do not want to use a point-to-point connection, refer to the logic analyzer or external oscilloscope operating system instructions for setting up the instrument on the network.

Using a Point-to-Point Network

To set up a point-to-point connection between the logic analyzer and the oscilloscope, use the cross-over (blue) cable (provided with the E5850A time correlation fixture) to connect the instruments.

1 Connect one end of the cross-over cable to the network interface on the logic analyzer and the other end of the cable to the network interface on the oscilloscope.

2 Configure the networking software on the oscilloscope (see Oscilloscope Point-to-Point Network Set Up (see page 10)).

3 Configure the networking software on the logic analyzer (see Logic Analyzer Point-to-Point Network Set Up (see page 11)).

Oscilloscope Point-to-Point Network Set Up

1 Make sure networking is enabled on the oscilloscope.

2 Set the oscilloscope's IP Address to 192.0.2.231.

3 Set the Subnet Mask to 255.255.255.0.

4 If there is a WINS resolution option, disable it.

5 Remove any installed gateways.

6 If there is a DNS option, disable it.
7 On a 6000-series oscilloscope, select the LAN port as the I/O Controller:
   a Press the Utility button.
   b Press the I/O softkey.
   c Use the Entry knob to select LAN.
   d Press the Controller softkey.

See Also
• Logic Analyzer Point-to-Point Network Set Up (see page 11)

Logic Analyzer Point-to-Point Network Set Up
1 From the Start menu, select Setting>Network and Dial-up Connection.
2 Right-click on Local Area Connection and select Properties.
3 Ensure that the TCP/IP component is installed, then select Properties.

4 In the Properties dialog, set the IP Address and Subnet Mask.
   a Set the IP Address to 192.0.2.232.
   b Set the Subnet Mask to 255.255.255.0.
5 Select the **Advanced** tab.
   a In the IP Settings tab, remove any installed gateways.
   b In the DNS tab, remove all DNS addresses from the list.
   c In the WINS tab, remove all WINS addresses from the list.
6 Close the dialogs and click **Yes** if prompted to continue.

**See Also**
- Oscilloscope Point-to-Point Network Set Up (see page 10)
- Step 2. Run the Add External Oscilloscope wizard (see page 13)
Step 2. Run the Add External Oscilloscope wizard

For step-by-step instructions on setting up the connection between the logic analyzer and the oscilloscope, run the Add External Oscilloscope wizard:

1. From the menu bar, select Setup> Add External Scope....

2. Follow the instructions in the wizard.

NOTE
The external oscilloscope module can cross-trigger with split logic analyzer modules; however, the "External Oscilloscope triggers Logic Analyzer" direction will not trigger the second half of a split logic analyzer.

See Also
- Additional Connection Information (see page 13)
- Deleting the External Oscilloscope (see page 31)
- Finding the External Oscilloscope IP Address (see page 34)

Additional Connection Information
- Connecting the LAN (see page 13)
- Connecting the BNC Cables (see page 14)
- Connecting the Oscilloscope Probe to the Time Correlation Fixture (see page 14)
- Connecting the Logic Analyzer to the Time Correlation Fixture (see page 14)
- Connecting the Power Supply to the Time Correlation Fixture (see page 15)

Connecting the LAN
An external oscilloscope module uses a network connection between the oscilloscope and the 1680/90-series logic analyzer or the 16900-series logic analysis system to produce time-correlated measurements and to import oscilloscope data. The instruments must be connected on a local area network (LAN) or connected point-to-point with a cross-over cable (which is supplied with the E5850A time correlation fixture).
You can connect only one oscilloscope to the logic analysis system for time-correlated measurements. The logic analysis system does not support the connection of two or more oscilloscopes at once.

**Connecting the BNC Cables**

BNC cable connections depend on which model external oscilloscope you have.

For instructions for connecting BNC see the Add External Oscilloscope wizard.

**Connecting the Oscilloscope Probe to the Time Correlation Fixture**

It is important to use the same probe for the calibration procedure as you use to make measurements on your device under test. This provides the best possible deskew accuracy. All connections must include a ground connection.

Connect the external oscilloscope channel 1 probe to any point labeled CAL on the front of the E5850A time correlation fixture. Any point labeled CAL is equivalent to any other point labeled CAL.

- If you are using a differential probe, you must connect the (+) probe terminal to the CAL terminal and the (-) probe terminal to the GND connection on the time correlation fixture.
- If you are using a grabber probe, connect the grabber probe to the CAL terminal on the front of the time correlation fixture. Then, connect the ground lead.
- If you are using a twin lead probe, connect the twin lead probe to the time correlation fixture. Then, connect the ground lead.
- If you are using a sharp-tip probe, connect the sharp tip probe to the CAL terminal on the front of the time correlation fixture.

**Connecting the Logic Analyzer to the Time Correlation Fixture**

It is important to use the same probes for the calibration procedure as you use to make measurements in the device under test. This provides the best possible deskew accuracy. All connections must include a ground connection.
There are three ways to connect to the CAL signals on the time correlation fixture:

- Using flying leads.
- Using high-density connectors (MICTOR or Samtec).
- Using grabber probes.

**Flying Leads (Socket Probe)**

Connect pod 2, channel 0 of the logic analyzer you are using to any point labeled CAL on the front of the time correlation fixture. If you are using multiple card logic analyzers, use pod 2 of the master card. Include a ground connection.

**High-Density Connectors**

If you are using a MICTOR connector on your device under test, use the MICTOR receptacle on the top of the time correlation fixture, which includes the CAL connection. Be sure to connect pod 2 of the logic analyzer to the even receptacle of the MICTOR high-density adapter cable. You can use a terminated or an unterminated high-density adapter cable.

If you are using Samtec connectors on your device under test, use the Samtec receptacle on the top of the time correlation fixture, which includes the CAL connection.

**Grabber Probe**

If you are using a grabber probe on your device under test, connect the grabber probe to the terminal labeled CAL. Be sure to include the ground connection.

**Connecting the Power Supply to the Time Correlation Fixture**

Connect the power supply to the time correlation fixture as shown in the Add External Oscilloscope wizard.

**WARNING**

Shock hazard. Use only the 0950-2546 power supply and cord.

**CAUTION**

Equipment damage. Use only the 0950-2546 power supply and cord.

The BNC cables and the power supply must remain connected to the time correlation fixture when you are performing a time correlated measurement. The probes only need to be connected during the calibration procedure.

**NOTE**

Remember that the skew is affected by cable lengths, probe types, and the instruments. If you change any of these, you will need to run the calibration procedure again. To re-run the calibration procedure, select **Setup->(External Oscilloscope)>Trigger...**; then, in the Trigger tab of the External Oscilloscope Setup dialog, click **Run Auto-Deskew...**
Step 3. Make a measurement

When the calibration is complete you may proceed with your measurements as follows:

1. If you used the E5850A time correlation fixture to calibrate deskew values, disconnect the external oscilloscope probe and the logic analyzer leads from the time correlation fixture.

2. Connect the oscilloscope probe and the logic analyzer leads to your device under test.

   Do not disconnect the BNC cables.

3. Set up the trigger condition.

4. Press the Run button on the logic analyzer front panel.

5. Select the Waveform tab to view your measurement results.

<table>
<thead>
<tr>
<th>Logic Analyzer Triggers External Oscilloscope</th>
</tr>
</thead>
<tbody>
<tr>
<td>When the software is configured for <strong>Logic Analyzer triggers External Oscilloscope</strong>, you can set any trigger condition you desire in the logic analyzer. However, do not change the oscilloscope's trigger setup.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>External Oscilloscope Triggers Logic Analyzer</th>
</tr>
</thead>
<tbody>
<tr>
<td>When the software is configured for <strong>External Oscilloscope triggers Logic Analyzer</strong>, you may set any trigger condition you desire in the oscilloscope. However, do not change the logic analyzer's trigger setup.</td>
</tr>
</tbody>
</table>

See Also
- Working with Markers (see page 17)
- General Triggering Problems (see page 36)
2 Working with Markers

Marker Moves

Marker moves are coordinated between the logic analyzer and the oscilloscope. Markers are coordinated in time, relative to the trigger, taking the measured skew into account.

On the logic analyzer, the markers, called Ax(External Scope) and Bx(External Scope), are time correlated among all display windows that are displaying measurements from a given run. On the oscilloscope, there are two X-Axis (time) markers called Ax and Bx. Marker moves are coordinated between Ax(External Scope) and Ax and between Bx(External Scope) and Bx. The option to coordinate between Ax(External Scope) and Bx or Bx(External Scope) and Ax is not available.

Coordinated marker moves are useful for quickly identifying a given point in the trace on the separate logic analyzer and oscilloscope displays. The marker properties for the Ax(External Scope) and Bx(External Scope) markers can be accessed through the Markers menu.

Oscilloscope Markers

Ax Follows the Logic Analyzer’s Ax(External Scope)

When you move the Ax(External Scope) marker in the logic analyzer waveform display, a command is sent to the oscilloscope to position the Ax marker at the same point in time.

Bx Follows the Logic Analyzer’s Bx(External Scope)

When you move the Bx(External Scope) marker in the logic analyzer waveform display, a command is sent to the oscilloscope to position the Bx marker at the same point in time.

Logic Analyzer Markers

Ax(External Scope) Follows Oscilloscope’s Ax

When you move the Ax marker on the oscilloscope, the Ax(External Scope) marker in the logic analyzer waveform display is moved to the same point in time.

Bx(External Scope) Follows Oscilloscope’s Bx

When you move the Bx marker on the oscilloscope, the Bx(External Scope) marker in the logic analyzer waveform display is moved to the same point in time.
2 Working with Markers
After running the Add External Oscilloscope wizard, the external oscilloscope module appears in the Overview window with a connection to a new Waveform window.

You can insert rows of data to display captured logic analyzer data in the same Waveform window as imported oscilloscope data:

1. Right-click on a row in the Waveform window, and choose Insert Row Before... or Insert Row After....

2. In the Insert dialog, select the logic analyzer data you would like to display with the imported oscilloscope data, and click OK.
After inserting the row, the captured logic analyzer data appears in the Waveform window along with the imported oscilloscope data. For example:

Note that, in the Waveform window, you can group imported digital channels into buses (see "To group signals into a bus" (in the online help)).
To change imported oscilloscope data options

1. Click the external oscilloscope module's options button.

2. In the External Oscilloscope Setup dialog's Channels tab (see page 42), you can:
   - Select the oscilloscope channels whose data you want to import, including digital channels and buses from a mixed-signal oscilloscope.
   - Change oscilloscope analog channel signal names.
   - Change oscilloscope channel signal colors.
   - Specify other external oscilloscope setup options.

3. When you are done changing imported data options, click OK to close the External Oscilloscope Setup dialog.
3 Displaying Imported Oscilloscope Data
Controlling the External Oscilloscope via the Web

The External Scope Web Control VbaView window is an embedded Internet Explorer window pointed at the web interface of an external oscilloscope module.

Oscilloscope performance slows down when its web control interface is being used; we recommend that you only connect to the oscilloscope’s web control interface temporarily, to set up oscilloscope triggers, etc.; then, use the data import feature of the external oscilloscope module (see Displaying Imported Oscilloscope Data (see page 19)) to view the waveforms captured by the oscilloscope.

Make sure the oscilloscope’s web control interface is disconnected when running the external oscilloscope module’s automatic deskew calibration.

To use the External Scope Web Control window:

1. Make sure the web control feature is enabled on the oscilloscope.
2. After you have added the external oscilloscope (see Step 2. Run the Add External Oscilloscope wizard (see page 13)), choose Window>New VbaView>External Scope Web Control....
3. In the Add New Window After dialog, select the external oscilloscope module, and click OK.
4. In the External Scope Web Control window, click the Web Control navigation bar to control the oscilloscope via its web interface.

If you see a blank screen (for example, if you installed a newer version of Internet Explorer or a Windows Service Pack that has removed the Java Virtual Machine (JVM)), you need to download a JVM to enable the web control feature. For example, you can download Sun’s Java Virtual Machine freely from "www.java.com".

Depending on the particular oscilloscope, the External Scope Web Control window looks something like:
In this case, clicking the Remote Front Panel link results in a window like:
Controlling the External Oscilloscope via the Web

External Oscilloscope Time Correlation and Data Display Online Help
5

Loading and Saving Configurations

When saving a configuration that includes an external oscilloscope module, the last skew run is saved along with the host name of the external oscilloscope. The oscilloscope setup (and data if you choose) will also be saved in the logic analyzer's configuration file.

When the configuration is loaded at a later time, the logic analysis system will automatically connect to the external oscilloscope and restore the setup that was saved. If the oscilloscope is not available on the network when the configuration is loaded this automatic connection and setup will fail.

If the external oscilloscope is a shared resource and is likely to be moved to another location, this option can have undesired effects. If the oscilloscope is on the network with the same Host Name or IP Address, the saved configuration will be loaded into that oscilloscope, possibly changing a setup that someone else has created.

NOTE
If two logic analyzers attempt to connect to a single oscilloscope, an error message will appear stating that the oscilloscope is locked by another user.

See Also
- "To save a configuration file" (in the online help)
- "To open a configuration file" (in the online help)
- "ALA vs. XML, When to Use Each Format" (in the online help)
5 Loading and Saving Configurations
6 Changing External Oscilloscope Setup Options

1 Choose the one of the commands from the **Setup**(External Oscilloscope) menu.

   ![Setup Menu]

The External Oscilloscope Setup dialog is opened with one of these tabs selected:

<table>
<thead>
<tr>
<th>Channels tab (see page 42)</th>
<th>Lets you select the oscilloscope channels to import data from and lets you specify other external oscilloscope setup options.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trigger tab (see page 43)</td>
<td>Used for setting the trigger direction and running the trigger deskew.</td>
</tr>
<tr>
<td>Connection tab (see page 44)</td>
<td>Shows the oscilloscope name or IP address, model, and serial number.</td>
</tr>
</tbody>
</table>

2 Make the desired changes.

3 Click **OK**.
Deleting the External Oscilloscope

To delete the external oscilloscope:

1. Choose Setup>(External Oscilloscope)>Delete from the menu bar.

See Also

- Getting Started, Step 2. Run the Add External Oscilloscope wizard (see page 13)
Deleting the External Oscilloscope
8
External Oscilloscope Troubleshooting

General Troubleshooting

- Finding the External Oscilloscope IP Address (see page 34)
- LAN Problems (see page 35)
- General Triggering Problems (see page 36)
- Unexpected or Inconsistent Results (see page 38)
- Correlation Drift Over Long Acquisitions (see page 39)
Finding the External Oscilloscope IP Address

The external oscilloscope time correlation and data display software requires the external oscilloscope's IP address. To find the external oscilloscope IP address:

- On an Agilent Infinium oscilloscope, select Utilities->GPIB Setup....

  The IP address is shown in the LAN Interface portion of the window. Ignore the brackets and text, and use only the numbers (such as 130.29.68.220). Use that string in the Add External Oscilloscope wizard.

- On an Agilent 6000 Series oscilloscope, press the front panel Utilities button; then, press the I/O softkey.

  The IP address is shown in the LAN portion of the resulting I/O configuration information box. Use that IP address string in the Add External Oscilloscope wizard.

If this string is not entered correctly or if someone changes the external oscilloscope's IP address, the logic analyzer will not be able to communicate with the oscilloscope. If the string happens to correspond to another oscilloscope on the network, the logic analyzer may find and connect to that oscilloscope, giving the appearance that you are correctly connected when in fact you are not.

If you enter a string that does not correspond to any device on your network, the software may appear to hang for several minutes while it searches for the device. Only one connection from a logic analyzer to a given oscilloscope can be supported.
LAN Problems

If you see a LAN error message:

- If you are using a 6000-series oscilloscope, make sure the LAN port is selected as the I/O Controller. (Press the Utility button; then, press the I/O softkey; use the Entry knob to select LAN; then, press the Controller softkey.)

- Check the LAN connections to the external oscilloscope and the logic analysis system.

- Check with your LAN administrator to ensure that the LAN is currently functioning. In the Connection tab of the External Oscilloscope Setup dialog, make sure the correct IP address is entered.

- If errors are reported, ask your LAN administrator to help you establish networking on the logic analyzer and oscilloscope. Cycle power on both instruments.

- If problems persist, contact Agilent Technologies for technical support.

Only one logic analysis system may connect to the external oscilloscope via the LAN

If two logic analysis systems try to connect to the same external oscilloscope, a message will appear stating that the oscilloscope is locked by another user. Connection to multiple external oscilloscopes from one logic analysis system is not supported.

See Also

- Finding the External Oscilloscope IP Address (see page 34)
General Triggering Problems

- Logic analyzer triggers external oscilloscope (see page 36)
- External oscilloscope triggers logic analyzer (see page 36)
- Why isn't the red trigger marker where I expect? (see page 36)
- Check cable connections (see page 36)
- Check probe connections (see page 36)
- Use grounds (see page 36)
- External oscilloscope must be in the correct mode (see page 37)
- Ensure no one else is using the external oscilloscope (see page 37)

**Logic analyzer triggers external oscilloscope**

When **Logic Analyzer triggers External Oscilloscope** is selected, the oscilloscope is configured to trigger on a rising edge of Aux Trig In at 1.0 V. If you manually change the oscilloscope trigger, the logic analysis system will automatically restore the oscilloscope's trigger condition to trigger on the rising edge of Aux Trig In at 1.0 V the next time you run the logic analyzer. You can set any trigger condition you desire in the logic analyzer because you are using it to trigger the oscilloscope.

**External oscilloscope triggers logic analyzer**

When **External Oscilloscope triggers Logic Analyzer** is selected, the logic analyzer is configured to trigger on an external Trigger In. If you manually change the logic analyzer trigger, you will not be able to correctly time-correlate the instruments. You may set any trigger condition you desire in the oscilloscope because you are using it to trigger the logic analyzer.

**Why isn't the red trigger marker where I expect?**

Whenever you are using the external oscilloscope module, you are performing a multiple instrument measurement. Measurements from each instrument are time correlated, but each instrument retains its actual trigger point.

**Check cable connections**

The BNC cables must remain connected between the logic analyzer, the time correlation fixture, and the oscilloscope whenever you are using the time correlation feature.

**Check probe connections**

Be sure you are using the correct logic analyzer cables. Trace the cables from the logic analyzer to the E5850A time correlation fixture or device under test.

Be sure you are using the correct oscilloscope probe. Follow it from the instrument to the E5850A time correlation fixture or the device under test.

**Use grounds**

Your connections to the front of the time correlation fixture must include grounds. For example, you should connect the oscilloscope probe ground clip to the ground terminal on the E5850A time correlation fixture.
Ground leads for each logic analyzer pod, and preferably each logic analyzer channel should be connected to a ground terminal on the E5850A fixture too.

**Note that only Single Sweep, Real Time acquisition can be meaningfully correlated with a logic analyzer. Meaningful correlation may not be possible if the oscilloscope is set to sample in Equivalent Time, or if the oscilloscope sweep is set to Sweep or Triggered Sweep.**

If someone else is using the external oscilloscope, either from the front panel or via the LAN, the logic analysis system will not be able to correctly control the oscilloscope.
Unexpected or Inconsistent Results

If you are experiencing unexpected or inconsistent deskew results, check the following items.

- Check cable connections (see page 36)
- Check probe connection (see page 36)
- External oscilloscope must be in the correct mode (see page 37)
- Ensure no one else is using the external oscilloscope (see page 37)
Correlation Drift Over Long Acquisitions

If you see correlation drift in long acquisitions as markers get farther away from the trigger, you can fix the problem by using the logic analysis system's 10 MHz CLOCK IN input (if present) to keep the oscilloscope and logic analyzer in sync.

The logic analysis system's CLOCK IN input is auto-sensing at power up; therefore, to use this input:

1. Make sure the logic analysis system is powered off.
2. Set up the 10 MHz clock source, 5.5 V max pk, either as an output from the oscilloscope or from another source that is fed into both the oscilloscope and logic analysis system.
3. Connect the clock source to the logic analysis system's CLOCK IN input BNC.
4. Power on the logic analysis system.
9

External Oscilloscope Reference

- External Oscilloscope Setup Dialog (see page 42)
External Oscilloscope Setup Dialog

- Channels Tab (see page 42)
- Trigger Tab (see page 43)
- Connection Tab (see page 44)

Channels Tab

The Channels tab lets you select the oscilloscope channels to import data from and lets you specify other external oscilloscope setup options.

<table>
<thead>
<tr>
<th>Import Channels</th>
<th>Lets you choose oscilloscope channels to import data from, rename oscilloscope channel signals, and change the color associated with channel data. The color associated with a channel is used when the analog signal is inserted into a Waveform display window. Changing a channel’s color in this dialog does not affect the color of waveforms currently displayed.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import Digital Channels and Buses</td>
<td>Lets you import digital channels and defined buses from a mixed-signal oscilloscope and change the color associated with digital channel data. The color associated with digital channels and buses is used when the signals are inserted into a Waveform display window. Changing the color in this dialog does not affect the color of waveforms currently displayed. Note that, in the Waveform window, you can group imported digital channels into buses (see &quot;To group signals into a bus&quot; (in the online help)).</td>
</tr>
</tbody>
</table>
See Also

- Connection Tab (see page 44)
- Trigger Tab (see page 43)
- Loading and Saving Configurations (see page 27)

**Trigger Tab**

The Trigger tab is used for setting the trigger direction and running the trigger deskew.

### Table: Trigger Tab Settings

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save External Oscilloscope Setup with Configuration</td>
<td>Specifies whether the external oscilloscope’s configuration settings will be saved along with the time correlation settings when saving the logic analyzer’s configuration file. When enabled and the logic analyzer configuration file is loaded, the logic analysis system will attempt to reload the external oscilloscope settings saved earlier. <strong>Note:</strong> The Agilent Logic Analyzer application will not load external oscilloscope settings from one oscilloscope model into a different oscilloscope model. For example, settings for a Infiniium 54810A oscilloscope will not load into a Infiniium 54831B oscilloscope.</td>
</tr>
<tr>
<td>Limit Import to N Samples</td>
<td>Used to limit the number of oscilloscope data samples to import.</td>
</tr>
<tr>
<td>Trigger Direction</td>
<td>The <strong>Logic Analyzer triggers External Oscilloscope</strong> option sets up the logic analyzer and oscilloscope so that when the logic analyzer generates the trigger signal, the oscilloscope receives the signal through its Aux Trig In/Ext Trig channel and begins capturing data. You must manually set up the logic analyzer trigger. The <strong>External Oscilloscope triggers Logic Analyzer</strong> option sets up the logic analyzer and oscilloscope so that when the oscilloscope generates the trigger signal, the logic analyzer receives the signal through its Trigger In port and begins capturing data. You must manually set up the oscilloscope trigger. Note that the oscilloscope will not trigger the second half of a split logic analyzer. The <strong>Analyzer</strong> selection lets you choose the appropriate logic analyzer module for time correlation with the external oscilloscope.</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Trigger Deskew    | The **Automatic** option specifies that either default deskew values or the deskew values determined by the calibration procedure are used. Automatic deskew gives two separate deskew values, one for each trigger direction. To re-run the automatic deskew, click **Run Auto-Deskew...**  
**Note:** Make sure the external oscilloscope’s web control interface is disconnected before running the automatic deskew calibration procedure.  
**Note:** Deskew calibration values differ depending upon the direction of the trigger.  
The **Manual** options lets you enter a deskew value in the numeric field provided. The deskew value entered is used for both trigger directions (that is, manual deskew mode does not maintain separate values for each trigger direction).  
**Note:** When **Automatic** deskew is selected, the deskew value is reset to the value obtained during the last calibration procedure. |

**See Also**
- Connection Tab (see page 44)
- Channels Tab (see page 42)

**Connection Tab**

The Connection tab shows the external oscilloscope name or IP address, model, and serial number. If the oscilloscope becomes disconnected, you can reconnect through the Connection tab by clicking **Reconnect**.
**See Also**

- Channels Tab (see page 42)
- Trigger Tab (see page 43)
- Finding the External Oscilloscope IP Address (see page 34)
10

External Oscilloscope Concepts

The following information helps explain how the external oscilloscope connection works.

- Trigger Deskew (see page 48)
- How the Calibration Procedure Works (see page 49)
- Uncertainty (see page 52)
- What Do the Skew Numbers Mean? (see page 53)
Trigger Deskew

When adding an external oscilloscope or running automatic deskew, trigger deskew values can be obtained by:

- **Using default calibration values** – In this case, default (typical) values for the logic analyzer and oscilloscope are used. This is sufficient for most customers.

- **Using previous calibration values** – This is appropriate when you have previously performed the calibration procedure and the hardware setup (instruments, probing, and cabling) has not changed. The previous values are used.

- **Performing the calibration procedure (which requires the E5850A time correlation fixture)** – To provide the minimum skew possible between the two instruments, the skew is measured by the calibration procedure.

After you have run the calibration procedure, you can remove the channel connections from the front of the E5850A time correlation fixture. When calibration is complete, all of your oscilloscope and logic analysis channels are available for probing your device under test.

Remember that the skew is affected by cable lengths, probe types, and the instruments themselves. If any of these change, you need to perform the calibration procedure again.
How the Calibration Procedure Works

- Propagation Delays (see page 49)
- Trigger Points are Different (see page 49)
- The Objective (see page 50)
- Setup Matters (see page 50)
- The CAL Signal (see page 50)
- Logic Analyzer Triggers External Oscilloscope (see page 50)
- Measuring the Skew (see page 50)
- An Average is Used (see page 51)
- External Oscilloscope Triggers Logic Analyzer (see page 51)
- The Setup is Ready (see page 51)

Propagation Delays

The logic analyzer and the external oscilloscope are able to drive a signal out of their chassis when a trigger condition occurs. These signals are Trigger Out on the logic analyzer and Aux Out on the oscilloscope.

The logic analyzer and the oscilloscope are also able to arm and/or trigger on the receipt of an external signal. These signals are Trigger In on the logic analyzer and Aux Trig In on the oscilloscope.

On both instruments, there is a propagation time between when a trigger event occurs and when its output signal is driven, and a propagation delay between when an input signal occurs and when the instrument actually triggers. There will also be propagation time in the cable between the instruments. We call the sum of all these propagation times the skew between the instruments.

Trigger Points are Different

For example, you can:

1. Connect a 50 ohm cable from the logic analyzer Trigger Out to the oscilloscope Aux Trig In.
2. Set a trigger condition of your choice on the logic analyzer.
3. Set the oscilloscope to Edge trigger on Aux Trig In at 1.0 V.
4. Run the oscilloscope.
5. Run the logic analyzer.

After the logic analyzer triggers, the oscilloscope will trigger. Both instruments will identify their trigger point. Unfortunately, because of the skew, these trigger points will not represent the same point in time. Unless the signal(s) being probed have unique identifying patterns, it may be very difficult or impossible to tell which edge(s) on one instrument correspond to which edge(s) on the other instrument.
The Objective
The point of the calibration procedure is to measure the skew between the instruments, remember the results of those measurements, and take those results into account when displaying subsequent logic analyzer and oscilloscope measurements so that time correlated marker moves can be created.

Setup Matters
It is important to be aware that the skew measurement is specific to the setup used for the measurement. The skew will change for different models of logic analyzers and oscilloscopes. Skew will vary based on the type and length of oscilloscope probe used. Skew will vary among the various probing options available for logic analysis modules such as flying leads, MICTOR connectors, Samtec connectors, etc. For the best possible time correlation, you must perform the calibration procedure with the same probing you will later use for measurements on your device under test.

The CAL Signal
The skew is measured by probing the CAL signal of the E5850A time correlation fixture with both Pod 2, Channel 0 of the logic analysis module and Channel 1 of the oscilloscope.

The CAL signal is a low frequency oscillator (approximately 62 kHz, with a 16 usec period). Because the period of this oscillator is at least two decimal orders of magnitude greater than the skew between the instruments, we know that the edge nearest the trigger is the same edge on both instruments.

It is critically important that the instrument that is to receive the external trigger signal is running, armed, and waiting before the driving instrument sends the trigger signal. If that is not the case, the instruments could very well be looking at different edges of the oscillator.

During the calibration procedure, and during subsequent regular single or repetitive runs, the external oscilloscope software ensures that the instruments are always armed and run in the correct sequence.

Analyzer Triggers
To measure skew in the Logic Analyzer triggers External Oscilloscope direction, the external oscilloscope software sets up both the logic analyzer and the oscilloscope. The logic analyzer is placed in Timing Mode at its highest sample rate (shortest sample period). A signal name is defined for the "DeskewEdge" (CAL signal) provided by the E5850A time correlation fixture. The logic analyzer is configured to trigger on the rising edge of the "DeskewEdge" signal. The oscilloscope is configured to trigger on its Aux Trig In line, and Channel 1 is turned on and configured to measure the "DeskewEdge" signal from the time correlation fixture. It is set up for Single Sweep, Real Time Sampling Mode at its maximum Sampling Rate and maximum Memory Depth.

Measuring the Skew
The skew is measured by first running the oscilloscope. After the logic analyzer is armed, it is run. The logic analyzer triggers on the next edge of "DeskewEdge", drives Trigger Out to the oscilloscope, which then triggers. The software retrieves the captured Channel 1 waveform from the
oscilloscope and measures the time from the trigger point to the rising edge on that waveform. The rising edge will occur earlier in time than the trigger. This time is the skew.

The measurement is repeated several times and the average is taken to be the skew. The reason for taking the average of multiple measurements is because the logic analyzer is sampling the "DeskewEdge" signal at a regular interval. The edge may actually occur near the beginning or near the end of the logic analyzer's sample period. The oscilloscope is also sampling at a regular interval, generally at a much higher frequency (shorter period). Because of the different and asynchronous sampling between the two instruments, a skew of +/- one analyzer sample period can occur in any single measurement.

Measuring skew in the External Oscilloscope triggers Logic Analyzer direction is very similar to the Logic Analyzer triggers External Oscilloscope direction. The oscilloscope is set up to trigger on a rising edge on Channel 1 and drive Aux Out (TTL Trig Out) to the logic analysis system Trigger In. The logic analysis module is configured to trigger on Trigger In. When the measurement is run, the analysis module is run first so it is armed and waiting for the Aux Out/Trigger In signal from the oscilloscope. When the oscilloscope is run, it triggers and drives the trigger signal to the logic analysis system which then triggers and fills analysis memory. (Note that oscilloscopes that have a "TTL Trig Out" port can drive the logic analyzer's Trigger In input directly, while oscilloscopes that have "Aux Out" ports must be routed through the E5850A time correlation fixture for buffering.) The skew is then measured as the time between when the rising edge occurred and the trigger occurred in the logic analysis system. The measurement is run several times and an average is taken.

The analyzer pod and oscilloscope probe may now be disconnected from the time correlation fixture and used to probe the device under test.

Remember that only Single Sweep, Real Time acquisition can be meaningfully correlated with a logic analyzer.
Uncertainty

Because the logic analyzer samples signals at intervals of one duration and the oscilloscope will usually sample at intervals of an entirely different duration, and because signals can actually transition at any point in time with any possible relation to the sample period(s), there will always be some uncertainty about when the signal actually transitioned versus when the analyzer noticed the transition.

Another source of uncertainty is the circuit used by the intermodule bus (IMB) to cross-correlate the times of trigger events from different modules. This circuitry has a resolution of 2 ns.

The uncertainty will always be at least +/- one timing analyzer sample period plus 2 ns of intermodule bus uncertainty.

During the calibration procedure, the maximum and minimum skew are measured. If the maximum measured skew is outside the expected range, it can indicate that one or more of the connections to the time correlation fixture were not made or were made incorrectly. A warning dialog will appear, suggesting that you check all the connections and run the calibration procedure again.
What Do the Skew Numbers Mean?

The skew (which is displayed within the Trigger tab of the External Oscilloscope Setup dialog) is the average trigger delay that is introduced external to the logic analyzer. The portion of the total skew that is internal to the logic analysis system is compensated for internally on a per-run basis. This internally measured skew is added to the constant skew that is displayed to compute the total skew. The total skew is added to the trigger time for the external oscilloscope, thereby time-correlating its trigger position with the trigger position of the analyzer.

The skew number will be positive when the analyzer triggers the external oscilloscope. When the analyzer triggers the oscilloscope, a delay occurs between the time when the analyzer sees the trigger condition and when the Trigger Out signal arrives at the oscilloscope Aux Trig In.

The skew number will be negative when the external oscilloscope triggers the analyzer. When the oscilloscope triggers the analyzer, a delay occurs between the time when the oscilloscope sees the trigger condition and when the Aux Out signal arrives at the logic analyzer Trigger In.

In the Trigger tab of the External Oscilloscope Setup dialog, you can use the **Manual** Trigger Deskew to change the fixed part of the total skew computation. This feature can be used to remove constant skew that was not measured during the Auto Deskew. If you use different probing accessories when you probe your device under test than when you ran the Auto Deskew, you will be causing additional constant skew. This is one example of where **Manual** Trigger Deskew can be useful.
The *Agilent Logic Analyzer* application includes the COM Automation Server. This software lets you write programs that control the *Agilent Logic Analyzer* application from remote computers on the Local Area Network (LAN).

In a COM automation program, you can configure a module by:

- Loading a configuration file (which configures the complete logic analyzer setup).
- Using the "Module" (in the online help) object's "DoCommands" (in the online help) method with an XML-format string parameter (see Module Setup, XML Format (see page 57)).

You can get information about a module's configuration using the Module object's "QueryCommand" (in the online help) method. Queries supported by the External Oscilloscope module are listed below.

For more information about logic analyzer COM automation and module objects in general, see "COM Automation" (in the online help).

**XML-Based Queries Supported**

The External Oscilloscope module supports the following XML-based queries (made with the "Module" (in the online help) object's "QueryCommand" (in the online help) method).

<table>
<thead>
<tr>
<th>Query</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GetAllSetup</td>
<td>Returns the current setup, using the full tag set, used for writing generic configuration files (see the XML format Module Setup, XML Format (see page 57)).</td>
</tr>
</tbody>
</table>

**See Also**

- "COM Automation" (in the online help)
- Module Setup, XML Format (see page 57)
When you save logic analyzer configurations to XML format files, setup information for the External Oscilloscope module is included.

This XML format setup information is also used when writing COM automation programs to control the logic analyzer from a remote computer.

XML elements for the External Oscilloscope module have the following hierarchy:

- `<BusSignalSetup>` (see page 62)
- `<BusSignals>` (see page 61)
  - `<Folder>` (see page 74)
    - `<BusSignal>` (see page 60)
    - `<Channels>` (see page 66)
    - `<Names>` (see page 77)
    - `<Name>` (see page 76)
- `<ChannelsSetup>` (see page 67)
- `<TriggerSetup>` (see page 87)
- `<ConnectionSetup>` (see page 68)
- `<Markers>` (see page 75)
- `<Programming>` (see page 79)
- `<Data>` (see page 69)
  - `<Channel1/2/3/4>` (see page 63)
    - `<Channel1/2/3/4DataTable>` (see page 65)
      - `<AnalogDataSource>` (see page 59)
        - `<SetupInfo>` (see page 82)
      - `<TimeDataSource>` (see page 86)
        - `<SetupInfo>` (see page 85)
      - `<SampleNumberDataSource>` (see page 81)
        - `<SetupInfo>` (see page 84)
  - `<DigitalChannels>` (see page 71)
    - `<WaveformData>` (see page 88)
  - `<Pod1/2>` (see page 78)
    - `<DigitalChannelsDataTable>` (see page 72)
      - `<DigitalDataSource>` (see page 73)
        - `<SetupInfo>` (see page 83)
      - `<TimeDataSource>` (see page 86)
        - `<SetupInfo>` (see page 85)
      - `<SampleNumberDataSource>` (see page 81)
        - `<SetupInfo>` (see page 84)

See Also: • "XML Format" (in the online help)
• Module Control, COM Automation (see page 55)
<AnalogDataSource> Element

The <AnalogDataSource> element contains information about the external oscilloscope channel's voltage column in the binary data file.

**Attributes**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>'Page'</td>
</tr>
</tbody>
</table>

**Children**

This element can have the following children: <SetupInfo> (for AnalogDataSource) (see page 82).

**Parents**

This element can have the following parents: <Channel1/2/3/4DataTable> (see page 65).

**Example**

```
<AnalogDataSource Type='Page'>
  <SetupInfo RowCount='1048000' PageSize='49152' YInc='0.15625' YOrg='8.55' YRef='0' FileOffset='0'/>
</AnalogDataSource>
```
The `<BusSignal>` element contains an oscilloscope channel signal definition.

### Attributes

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color</td>
<td>'hex_RGB_value' (the color associated with this channel's data)</td>
</tr>
<tr>
<td>DefaultLabel</td>
<td>'F' (false) or 'T' (true)</td>
</tr>
<tr>
<td>Enabled</td>
<td>'F' (false) or 'T' (true)</td>
</tr>
<tr>
<td>Name</td>
<td>'string'</td>
</tr>
</tbody>
</table>

### Children

This element can have the following children: `<Channels>` (see page 66), `<Names>` (see page 77).

### Parents

This element can have the following parents: `<Folder>` (see page 74).

### Examples

```xml
<BusSignal Name='My Scope C1' Enabled='T' Color='hFFFF00'>
  <Channels>1</Channels>
</BusSignal>

<BusSignal Name='My Scope D15-0' DefaultLabel='T'>
  <Channels>D[15:0]</Channels>
  <Names>
    <Name Index='0'>D0</Name>
    <Name Index='1'>D1</Name>
    <Name Index='2'>D2</Name>
    <Name Index='3'>D3</Name>
    <Name Index='4'>D4</Name>
    <Name Index='5'>D5</Name>
    <Name Index='6'>D6</Name>
    <Name Index='7'>D7</Name>
    <Name Index='8'>D8</Name>
    <Name Index='9'>D9</Name>
    <Name Index='10'>D10</Name>
    <Name Index='11'>D11</Name>
    <Name Index='12'>D12</Name>
    <Name Index='13'>D13</Name>
    <Name Index='14'>D14</Name>
    <Name Index='15'>D15</Name>
  </Names>
</BusSignal>
```
<BusSignals> Element

The <BusSignals> element contains oscilloscope channel signal definitions.

**Children**
This element can have the following children: <Folder> (see page 74).

**Parents**
This element can have the following parents: <BusSignalSetup> (see page 62).

**Example**

```xml
<BusSignals>
  <Clear />
  <Folder Name='Channel 1'>
    <BusSignal Name='My Scope C1' Enabled='T' Color='hFFFF00'>
      <Channels>C1</Channels>
    </BusSignal>
  </Folder>
  <Folder Name='Channel 2'>
    <BusSignal Name='My Scope C2' Enabled='T' Color='h00FF00'>
      <Channels>C2</Channels>
    </BusSignal>
  </Folder>
  <Folder Name='Digital Channels' Enabled='T' Color='h00FFFF'>
    <BusSignal Name='My Scope D15-0' DefaultLabel='T'>
      <Channels>D[15:0]</Channels>
      <Names>
        <Name Index='0'>D0</Name>
        <Name Index='1'>D1</Name>
        <Name Index='2'>D2</Name>
        <Name Index='3'>D3</Name>
        <Name Index='4'>D4</Name>
        <Name Index='5'>D5</Name>
        <Name Index='6'>D6</Name>
        <Name Index='7'>D7</Name>
        <Name Index='8'>D8</Name>
        <Name Index='9'>D9</Name>
        <Name Index='10'>D10</Name>
        <Name Index='11'>D11</Name>
        <Name Index='12'>D12</Name>
        <Name Index='13'>D13</Name>
        <Name Index='14'>D14</Name>
        <Name Index='15'>D15</Name>
      </Names>
    </BusSignal>
  </Folder>
</BusSignals>
```
<BusSignalSetup> Element

The <BusSignalSetup> element contains a <BusSignals> element.

Children
This element can have the following children: <BusSignals> (see page 61).

Parents
This element can have the following parents: "<Module>" (in the online help).

When used in COM automation, this element is returned by the "QueryCommand method" (in the online help)'s GetAllSetup query. You can also use this element string as an XMLCommand with the "DoCommands method" (in the online help) to configure the External Oscilloscope module.

Example

```xml
<BusSignalSetup>
  <BusSignals>
    <Clear />
    <Folder Name='Channel 1'>
      <BusSignal Name='My Scope C1' Enabled='T' Color='hFFFF00'>
        <Channels>C1</Channels>
      </BusSignal>
    </Folder>
    <Folder Name='Channel 2'>
      <BusSignal Name='My Scope C2' Enabled='T' Color='h00FF00'>
        <Channels>C2</Channels>
      </BusSignal>
    </Folder>
    <Folder Name='Digital Channels' Enabled='T' Color='h00FFFF'>
      <BusSignal Name='My Scope D15-0' DefaultLabel='T'>
        <Channels>D[15:0]</Channels>
        <Names>
          <Name Index='0'>D0</Name>
          <Name Index='1'>D1</Name>
          <Name Index='2'>D2</Name>
          <Name Index='3'>D3</Name>
          <Name Index='4'>D4</Name>
          <Name Index='5'>D5</Name>
          <Name Index='6'>D6</Name>
          <Name Index='7'>D7</Name>
          <Name Index='8'>D8</Name>
          <Name Index='9'>D9</Name>
          <Name Index='10'>D10</Name>
          <Name Index='11'>D11</Name>
          <Name Index='12'>D12</Name>
          <Name Index='13'>D13</Name>
          <Name Index='14'>D14</Name>
          <Name Index='15'>D15</Name>
        </Names>
      </BusSignal>
    </Folder>
  </BusSignals>
</BusSignalSetup>
```
The `<Channel1/2/3/4>` element describes the part of the binary data file that contains a particular oscilloscope channel's data.

### Attributes

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MaxVoltage</td>
<td>'floating_point_number' (maximum voltage for the full acquisition of this channel, represented in volts)</td>
</tr>
<tr>
<td>MinVoltage</td>
<td>'floating_point_number' (minimum voltage for the full acquisition of this channel, represented in volts)</td>
</tr>
<tr>
<td>NumBytesPerSample</td>
<td>'number' (number of bytes per sample in the oscilloscope data)</td>
</tr>
<tr>
<td>NumSamples</td>
<td>'number' (number of &quot;points&quot; or samples in the oscilloscope data)</td>
</tr>
<tr>
<td>Valid</td>
<td>'F' (false) or 'T' (true, when data is valid)</td>
</tr>
<tr>
<td>XInc</td>
<td>'floating_point_number' (the X coordinate increment value in seconds)</td>
</tr>
<tr>
<td>XOrg</td>
<td>'floating_point_number' (the X origin's value in seconds)</td>
</tr>
<tr>
<td>XRef</td>
<td>'number' (the X coordinate value associated with the X origin)</td>
</tr>
<tr>
<td>YInc</td>
<td>'floating_point_number' (the Y coordinate increment value in volts)</td>
</tr>
<tr>
<td>YOrg</td>
<td>'floating_point_number' (the Y origin's value in volts)</td>
</tr>
<tr>
<td>YRef</td>
<td>'number' (the Y coordinate value associated with the Y origin)</td>
</tr>
</tbody>
</table>

### Children

This element can have the following children:
- `<Channel1/2/3/4DataTable>` (see page 65).

### Parents

This element can have the following parents: `<Data>` (see page 69).

### Example

```xml
(Channel1 Valid='T' XInc='5.0000000e-010' XOrg='-2.619995e-004' XRef='0' YInc='1.5625000e-001' YOrg='8.5500000e+000' YRef='0' MinVoltage='-3.0800000e+000' MaxVoltage='5.6700000e+000' NumBytesPerSample='1' NumSamples='1048000'>
(Channel1DataTable RowCount='1048000' TriggerIndex='523999' OffsetTime='99.966666666667 ns' TimePrecision='1 ps' FileName='ext_scope_data02of02.mfb'>
<AnalogDataSource Type='Page'>
<SetupInfo RowCount='1048000' PageSize='49152' YInc='0.15625' YOrg='8.55' YRef='0' FileOffset='0'/>
</AnalogDataSource>
<TimeDataSource Type='Periodic'>
  <SetupInfo RowCount='1048000' TriggerIndex='523999' SamplePeriod='500 ps'/>
</TimeDataSource>
<SampleNumberDataSource Type='Periodic'>
  <SetupInfo RowCount='1048000' TriggerIndex='523999' SamplePeriod='1'/>
</SampleNumberDataSource>
</Channel1DataTable>
</Channel1>
The `<Channel1/2/3/4DataTable>` element describes the part of the binary data file that contains a particular oscilloscope channel's data.

### Attributes

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FileName</td>
<td>'relative_path_file_name'</td>
</tr>
<tr>
<td>OffsetTime</td>
<td>'number &quot;time_unit&quot; (in the online help)'</td>
</tr>
<tr>
<td>RowCount</td>
<td>'number'</td>
</tr>
<tr>
<td>TimePrecision</td>
<td>'number &quot;time_unit&quot; (in the online help)'</td>
</tr>
<tr>
<td>TriggerIndex</td>
<td>'number'</td>
</tr>
</tbody>
</table>

### Children

This element can have the following children: `<AnalogDataSource>` (see page 59), `<TimeDataSource>` (see page 86), `<SampleNumberDataSource>` (see page 81).

### Parents

This element can have the following parents: `<Data>` (see page 69).

### Example

```xml
<Channel1DataTable RowCount='1048000' TriggerIndex='523999'
  OffsetTime='99.966666666667 ns' TimePrecision='1 ps'
  FileName='ext_scope_data02of02.mfb'>
  <AnalogDataSource Type='Page'>
    <SetupInfo RowCount='1048000' PageSize='49152' YInc='0.15625'
      YOrg='-8.55' YRef='0' FileOffset='0'/>
  </AnalogDataSource>
  <TimeDataSource Type='Periodic'>
    <SetupInfo RowCount='1048000' TriggerIndex='523999'
      SamplePeriod='500 ps'/>
  </TimeDataSource>
  <SampleNumberDataSource Type='Periodic'>
    <SetupInfo RowCount='1048000' TriggerIndex='523999'
      SamplePeriod='1'/>
  </SampleNumberDataSource>
</Channel1DataTable>
```
<Channels> Element

The `<Channels>` element specifies the oscilloscope channel assigned to the signal name.

**Data**
This element's data is a string representing the oscilloscope channel for the signal.

**Parents**
This element can have the following parents: `<BusSignal>` (see page 60).

**Example**
```
<Channels>1</Channels>
```
<ChannelsSetup> Element

The <ChannelsSetup> element describes the external oscilloscope channels setup options.

### Attributes

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MemoryDepth</td>
<td>'number' (the number of oscilloscope data samples to import)</td>
</tr>
<tr>
<td>NumChannels</td>
<td>'number' (the number of oscilloscope channels)</td>
</tr>
<tr>
<td>SaveScopeSetup</td>
<td>'F' (false) or 'T' (true)</td>
</tr>
</tbody>
</table>

### Parents

This element can have the following parents: "<Module>" (in the online help).

When used in COM automation, this element is returned by the "QueryCommand method" (in the online help)'s GetAllSetup query. You can also use this element string as an XMLCommand with the "DoCommands method" (in the online help) to configure the External Oscilloscope module.

### Example

```
<ChannelsSetup NumChannels='2' SaveScopeSetup='T'
    MemoryDepth='1048576'/>
```
<ConnectionSetup> Element

The <ConnectionSetup> element describes the oscilloscope connection options.

Attributes

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LAProbe</td>
<td>'LAProbeGrabber', 'LAProbeMictor', 'LAProbeSamtec', or 'LAProbeSocket' (the probe connection from the analyzer to the deskewing signal)</td>
</tr>
<tr>
<td>Name</td>
<td>'string' (hostname of the oscilloscope to connect to)</td>
</tr>
<tr>
<td>ScopeProbe</td>
<td>'100-pin probe', '38-pin probe', 'Flying Lead probe', or 'ScopeProbeGrabber' (the probe connection from the oscilloscope to the deskewing signal)</td>
</tr>
</tbody>
</table>

Parents

This element can have the following parents: "<Module>" (in the online help).

When used in COM automation, this element is returned by the "QueryCommand method" (in the online help)’s GetAllSetup query. You can also use this element string as an XMLCommand with the "DoCommands method" (in the online help) to configure the External Oscilloscope module.

Example

```xml
<ConnectionSetup
    Name='130.29.68.220'
    LAProbe='LAProbeSocket'
    ScopeProbe='ScopeProbeGrabber'
/>```
<Data> Element

When data and setup information are saved to XML format configuration files, the <Data> element contains information about the binary data files that are saved.

Children  This element can have the following children: <Channel1/2/3/4> (see page 63), <DigitalChannels> (see page 63).

Parents  This element can have the following parents: "<Module>" (in the online help).

Example  <Data>

  <Channel1 Valid='T' XInc='5.000000e-010' XOrg='-2.668685e-004'
    XRef='0' YInc='6.250000e-002' YOrg='-4.984000e+000' YRef='0'
    MinVoltage='-1.047000e+000' MaxVoltage='2.016000e+000'
    NumBytesPerSample='1' NumSamples='1048600'>
    <Channel1DataTable RowCount='1048600' TriggerIndex='533737'
      OffsetTime='54 ns' TimePrecision='1 ps'
      FileName='ViewScope2_data03of04.mfb'>
      <AnalogDataSource Type='Page'>
        <SetupInfo RowCount='1048600' PageSize='49152'
          YInc='0.0625' YOrg='-4.984' YRef='0' YMin='-1.047'
          YMax='2.016' FileOffset='0' />
      </AnalogDataSource>
      <TimeDataSource Type='Periodic'>
        <SetupInfo RowCount='1048600' TriggerIndex='533737'
          SamplePeriod='500 ps' />
      </TimeDataSource>
      <SampleNumberDataSource Type='Periodic'>
        <SetupInfo RowCount='1048600' TriggerIndex='533737'
          SamplePeriod='1' />
      </SampleNumberDataSource>
    </Channel1DataTable>
  </Channel1>

  <Channel2 Valid='T' XInc='5.000000e-010' XOrg='-2.668680e-004'
    XRef='0' YInc='1.562500e-001' YOrg='2.000000e-001' YRef='0'
    MinVoltage='-2.460000e+000' MaxVoltage='5.360000e+000'
    NumBytesPerSample='1' NumSamples='1048600'>
    <Channel2DataTable RowCount='1048600' TriggerIndex='533736'
      OffsetTime='0 s' TimePrecision='10 ps'
      FileName='ViewScope2_data03of04.mfb'>
      <AnalogDataSource Type='Page'>
        <SetupInfo RowCount='1048600' PageSize='49152'
          YInc='0.15625' YOrg='0.2' YRef='0' YMin='2.46'
          YMax='5.36' FileOffset='2097200' />
      </AnalogDataSource>
      <TimeDataSource Type='Periodic'>
        <SetupInfo RowCount='1048600' TriggerIndex='533736'
          SamplePeriod='500 ps' />
      </TimeDataSource>
      <SampleNumberDataSource Type='Periodic'>
        <SetupInfo RowCount='1048600' TriggerIndex='533736'
          SamplePeriod='1' />
      </SampleNumberDataSource>
    </Channel2DataTable>
  </Channel2>
</Data>
12 External Oscilloscope Module Setup, XML Format

For the external oscilloscope module, there is a single binary data file that contains the module's sample number, voltage, and time data. Each channel's data is stored contiguously, with the XML elements under `<Data>` pointing to the byte offsets within the file for each channel. Data is dumped simply by sample/row, starting with the first sample of data, all the way through the last.

If the XML with data file is read back into the system, the paging information in the XML file is used to load the data by pages to increase performance. There is no checksumming of any kind on the data, so data integrity is assumed to be valid whenever these files are loaded. If the file is altered in any way, it should be kept consistent with the format described.

If you are interested in processing the binary data files saved with XML format configuration files, please contact Agilent Technologies ("http://www.agilent.com/find/contactus") for sample parsing code.
<DigitalChannels> Element

The <DigitalChannels> element describes the part of the binary data file that contains a particular oscilloscope's digital channels data.

**Children**
This element can have the following children: <WaveformData> (see page 88), <DigitalChannelsDataTable> (see page 72).

**Parents**
This element can have the following parents: <Data> (see page 69).

**Example**

```xml
<DigitalChannels>
  <WaveformData>
    <Pod1 Valid='T' XInc='1.000000e-009' XOrg='-2.668490e-004'
      XRef='0' YInc='1.000000e+000' YOrg='0.000000e+000'
      YRef='0' MinVoltage='0.000000e+000' MaxVoltage='0.000000e+000'
      NumBytesPerSample='1' NumSamples='524300' />
    <Pod2 Valid='T' XInc='1.000000e-009' XOrg='-2.668490e-004'
      XRef='0' YInc='1.000000e+000' YOrg='0.000000e+000'
      YRef='0' MinVoltage='0.000000e+000' MaxVoltage='0.000000e+000'
      NumBytesPerSample='1' NumSamples='524300' />
  </WaveformData>
  <DigitalChannelsDataTable RowCount='524300' TriggerIndex='266849'
    OffsetTime='0 s' TimePrecision='10 ps'
    FileName='ViewScope2_data03of04.mfb'>
    <DigitalDataSource Type='Page'>
      <SetupInfo RowCount='524300' BitsPerSample='16'
        PageSize='49152' BitsPerBonusBit='16'
        FileOffset='4194400' />
    </DigitalDataSource>
    <TimeDataSource Type='Periodic'>
      <SetupInfo RowCount='524300' TriggerIndex='266849'
        SamplePeriod='1 ns' />
    </TimeDataSource>
    <SampleNumberDataSource Type='Periodic'>
      <SetupInfo RowCount='524300' TriggerIndex='266849'
        SamplePeriod='1' />
    </SampleNumberDataSource>
  </DigitalChannelsDataTable>
</DigitalChannels>
```
<DigitalChannelsDataTable> Element

The <DigitalChannelsDataTable> element describes the part of the binary data file that contains a particular oscilloscope's digital channels data.

Attributes

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FileName</td>
<td>'relative_path_file_name'</td>
</tr>
<tr>
<td>OffsetTime</td>
<td>'number &quot;time_unit&quot; (in the online help)'</td>
</tr>
<tr>
<td>RowCount</td>
<td>'number'</td>
</tr>
<tr>
<td>TimePrecision</td>
<td>'number &quot;time_unit&quot; (in the online help)'</td>
</tr>
<tr>
<td>TriggerIndex</td>
<td>'number'</td>
</tr>
</tbody>
</table>

Children

This element can have the following children: <DigitalDataSource> (see page 73), <TimeDataSource> (see page 86), <SampleNumberDataSource> (see page 81).

Parents

This element can have the following parents: <DigitalChannels> (see page 71).

Example

```xml
<DigitalChannelsDataTable RowCount='524300' TriggerIndex='266849'
  OffsetTime='0 s' TimePrecision='10 ps'
  FileName='ViewScope2_data03of04.mfb'>
  <DigitalDataSource Type='Page'>
    <SetupInfo RowCount='524300' BitsPerSample='16'
               PageSize='49152' BitsPerBonusBit='16'
               FileOffset='4194400' />
  </DigitalDataSource>
  <TimeDataSource Type='Periodic'>
    <SetupInfo RowCount='524300' TriggerIndex='266849'
               SamplePeriod='1 ns' />
  </TimeDataSource>
  <SampleNumberDataSource Type='Periodic'>
    <SetupInfo RowCount='524300' TriggerIndex='266849'
               SamplePeriod='1' />
  </SampleNumberDataSource>
</DigitalChannelsDataTable>
```
<DigitalDataSource> Element

The <DigitalDataSource> element contains information about the external oscilloscope's digital data column in the binary data file.

### Attributes

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>'Page'</td>
</tr>
</tbody>
</table>

### Children
This element can have the following children: <SetupInfo> (for DigitalDataSource) (see page 83).

### Parents
This element can have the following parents:
<DigitalChannelsDataTable> (see page 72).

### Example

```xml
<DigitalDataSource Type='Page'>
  <SetupInfo RowCount='524300' BitsPerSample='16' PageSize='49152' BitsPerBonusBit='16' FileOffset='4194400' />
</DigitalDataSource>
```
<Folder> Element

The <Folder> element contains the bus/signal definition for an oscilloscope channel.

**Attributes**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>'string'</td>
</tr>
</tbody>
</table>

**Children**

This element can have the following children: <BusSignal> (see page 60).

**Parents**

This element can have the following parents: <BusSignals> (see page 61).

**Example**

```xml
<Folder Name='Channel 1'>
  <BusSignal Name='My Scope C1' Enabled='T' Color='hFFFF00'>
    <Channels>1</Channels>
  </BusSignal>
</Folder>
```
**<Markers> Element**

The `<Markers>` element describes the Ax and Bx oscilloscope marker times relative to the system trigger.

### Attributes

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MarkerAxTime</td>
<td>'floating_point_number' (relative to system trigger)</td>
</tr>
<tr>
<td>MarkerBxTime</td>
<td>'floating_point_number' (relative to system trigger)</td>
</tr>
</tbody>
</table>

### Parents

This element can have the following parents: "<Module>" (in the online help).

When used in COM automation, this element is returned by the "QueryCommand method" (in the online help)'s GetAllSetup query. You can also use this element string as an XMLCommand with the "DoCommands method" (in the online help) to configure the External Oscilloscope module.

### Example

```
<Markers
  MarkerAxTime='-0.000000005313333333333328'
  MarkerBxTime='0.000000018166666666666672'
/>
```
<Name> Element

The <Name> element gives a name to an individual digital channel imported from an external oscilloscope.

### Attributes

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index</td>
<td>'number'</td>
</tr>
</tbody>
</table>

### Parents

This element can have the following parents: <Names> (see page 77).

### Example

<Name Index='0'>D0</Name>
<Names> Element

The <Names> element contains the names of the digital channels imported from an external oscilloscope.

Children  
This element can have the following children: <Name> (see page 76).

Parents  
This element can have the following parents: <BusSignal> (see page 61).

Example  
<Names>
  <Name Index='0'>D0</Name>
  <Name Index='1'>D1</Name>
  <Name Index='2'>D2</Name>
  <Name Index='3'>D3</Name>
  <Name Index='4'>D4</Name>
  <Name Index='5'>D5</Name>
  <Name Index='6'>D6</Name>
  <Name Index='7'>D7</Name>
  <Name Index='8'>D8</Name>
  <Name Index='9'>D9</Name>
  <Name Index='10'>D10</Name>
  <Name Index='11'>D11</Name>
  <Name Index='12'>D12</Name>
  <Name Index='13'>D13</Name>
  <Name Index='14'>D14</Name>
  <Name Index='15'>D15</Name>
</Names>
<Pod1/2> Element

The <Pod1/2> element describes the part of the binary data file that contains a particular oscilloscope's digital data.

Attributes

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MaxVoltage</td>
<td>'floating_point_number' (maximum voltage for the full acquisition of this pod, represented in volts)</td>
</tr>
<tr>
<td>MinVoltage</td>
<td>'floating_point_number' (minimum voltage for the full acquisition of this pod, represented in volts)</td>
</tr>
<tr>
<td>NumBytesPerSample</td>
<td>'number' (number of bytes per sample in the oscilloscope data)</td>
</tr>
<tr>
<td>Num Samples</td>
<td>'number' (number of &quot;points&quot; or samples in the oscilloscope data)</td>
</tr>
<tr>
<td>Valid</td>
<td>'F' (false) or 'T' (true, when data is valid)</td>
</tr>
<tr>
<td>XInc</td>
<td>'floating_point_number' (the X coordinate increment value in seconds)</td>
</tr>
<tr>
<td>XOrg</td>
<td>'floating_point_number' (the X origin's value in seconds)</td>
</tr>
<tr>
<td>XRef</td>
<td>'number' (the X coordinate value associated with the X origin)</td>
</tr>
<tr>
<td>YInc</td>
<td>'floating_point_number' (the Y coordinate increment value in volts)</td>
</tr>
<tr>
<td>YOrg</td>
<td>'floating_point_number' (the Y origin's value in volts)</td>
</tr>
<tr>
<td>YRef</td>
<td>'number' (the Y coordinate value associated with the Y origin)</td>
</tr>
</tbody>
</table>

Parents

This element can have the following parents: <Data> (see page 69).

Example

```
<Pod1 Valid='T' XInc='1.000000e-009' XOrg='-2.668490e-004'
  YRef='0' YInc='1.000000e+000' YOrg='0.000000e+000'
  YRef='0' MinVoltage='0.000000e+000'
  MaxVoltage='0.000000e+000' NumBytesPerSample='1'
  NumSamples='524300' />

<Pod2 Valid='T' XInc='1.000000e-009' XOrg='-2.668490e-004'
  YRef='0' YInc='1.000000e+000' YOrg='0.000000e+000'
  YRef='0' MinVoltage='0.000000e+000'
  MaxVoltage='0.000000e+000' NumBytesPerSample='1'
  NumSamples='524300' />
```
<Programming> Element

The <Programming> element describes oscilloscope and logic analyzer setup information.

Attributes

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LATrigState</td>
<td>'string' (the XML trigger specification for the logic analyzer to do auto-deskew in state mode)</td>
</tr>
<tr>
<td>LATrigTiming</td>
<td>'string' (the XML trigger specification for the logic analyzer to do auto-deskew in timing mode)</td>
</tr>
<tr>
<td>ScopeEdgeSource</td>
<td>'Channel1', 'Channel2', 'Channel3', or 'Channel4'. (the edge source for the deskewing signal)</td>
</tr>
<tr>
<td>ScopeTrigMode</td>
<td>'TriggerModeAdvanced', 'TriggerModeEdge', or 'TriggerModeGlitch' (the oscilloscope’s trigger mode for deskewing)</td>
</tr>
<tr>
<td>ScopeTrigSweep</td>
<td>'TriggerSweepAuto', 'TriggerSweepSingle', or 'TriggerSweepTriggered' (the oscilloscope’s trigger sweep setting for deskewing)</td>
</tr>
<tr>
<td>ScopeAuxExtEdgeSlope</td>
<td>'SlopeNegative' or 'SlopePositive' (the slope for the oscilloscope’s deskewing signal)</td>
</tr>
<tr>
<td>ScopeAuxExtTrigLevel</td>
<td>'floating_point_number'</td>
</tr>
</tbody>
</table>

Parents

This element can have the following parents: "<Module>" (in the online help).

When used in COM automation, this element is returned by the "QueryCommand method" (in the online help)'s GetAllSetup query. You can also use this element string as an XMLCommand with the "DoCommands method" (in the online help) to configure theExternal Oscilloscope module.

Example

```xml
<Programming>
  ScopeTrigSweep='TriggerSweepSingle'
  ScopeTrigMode='TriggerModeEdge'
  ScopeEdgeSource='Channel1'
  ScopeAuxExtEdgeSlope='SlopePositive'
  ScopeAuxExtTrigLevel='0.000000e+000'
  LATrigTiming=''
  &lt;Module&gt;
  &lt;Trigger Mode='Timing'&gt;
  &lt;If&gt;
    &lt;Event Name='LATrigState'&gt;
    &lt;string&gt; (the XML trigger specification for the logic analyzer to do auto-deskew in state mode)
    &lt;/string&gt;
  &lt;/Event&gt;
  &lt;/If&gt;
  &lt;/Trigger Mode&gt;
&lt;/Module&gt;
```
LATrigState=''
&<Module>
&<Trigger Mode='State'>
&<StoreQual>
&<Event>
&<Anything/>
&</Event>
&</StoreQual>
&<Sequence Level='1'>
&<If>
&<Event>
&<Anything/>
&</Event>
&</If>
&<TriggerAction Operator='Fill Memory'>
&<StoreQual>
&<Event>
&<Anything/>
&</Event>
&</StoreQual>
&</TriggerAction>
&</Action>
&</Sequence>
&</Trigger>
&</Module>

'}
<SampleNumberDataSource> Element

The <SampleNumberDataSource> element contains information about the external oscilloscope channel's sample number column in the binary data file.

Attributes

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>'Periodic'</td>
</tr>
</tbody>
</table>

Children

This element can have the following children: <SetupInfo> (for SampleNumberDataSource) (see page 84).

Parents

This element can have the following parents:

<Channel1/2/3/4DataTable> (see page 65).

Example

```xml
<SampleNumberDataSource Type='Periodic'>
  <SetupInfo RowCount='1048000' TriggerIndex='523999' SamplePeriod='1'/>
</SampleNumberDataSource>
```
**<SetupInfo> Element (for AnalogDataSource)**

The `<SetupInfo>` element contains additional setup information for the `<AnalogDataSource>` (see page 59) element.

### Attributes

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FileOffset</td>
<td>'number' (bytes within the binary data file where the data begins)</td>
</tr>
<tr>
<td>PageSize</td>
<td>'number' (of bits per page of data)</td>
</tr>
<tr>
<td>RowCount</td>
<td>'number' (of samples)</td>
</tr>
<tr>
<td>YInc</td>
<td>'floating_point_number' (the Y coordinate increment value in volts)</td>
</tr>
<tr>
<td>YOrg</td>
<td>'floating_point_number' (the Y origin's value in volts)</td>
</tr>
<tr>
<td>YRef</td>
<td>'number' (the Y coordinate value associated with the Y origin)</td>
</tr>
</tbody>
</table>

### Parents

This element can have the following parents: `<AnalogDataSource>` (see page 59).

### Example

```
<SetupInfo RowCount='1048000' PageSize='49152' YInc='0.15625'
           YOrg='-8.55' YRef='0' FileOffset='0'/>
```
<SetupInfo> Element (for DigitalDataSource)

The <SetupInfo> element contains additional setup information for the <DigitalDataSource> element.

**Attributes**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BitsPerBonusBit</td>
<td>'number'</td>
</tr>
<tr>
<td>BitsPerSample</td>
<td>'number'</td>
</tr>
<tr>
<td>FileOffset</td>
<td>'number' (bytes within the binary data file where the data begins)</td>
</tr>
<tr>
<td>PageSize</td>
<td>'number' (of bits per page of data)</td>
</tr>
<tr>
<td>RowCount</td>
<td>'number' (of samples)</td>
</tr>
</tbody>
</table>

**Parents**

This element can have the following parents: <DigitalDataSource> (see page 73).

**Example**

```xml
<SetupInfo RowCount='524300' BitsPerSample='16'
            PageSize='49152' BitsPerBonusBit='16'
            FileOffset='4194400' />
```
### `<SetupInfo>` Element (for `SampleNumberDataSource`)

The `<SetupInfo>` element contains additional setup information for the `<SampleNumberDataSource>` (see page 81) element.

#### Attributes

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RowCount</td>
<td>'number' (of samples)</td>
</tr>
<tr>
<td>SamplePeriod</td>
<td>'1'</td>
</tr>
<tr>
<td>TriggerIndex</td>
<td>'number' (zero-based)</td>
</tr>
</tbody>
</table>

#### Parents

This element can have the following parents:
- `<SampleNumberDataSource>` (see page 81).

#### Example

```xml
<SetupInfo RowCount='1048000' TriggerIndex='523999' SamplePeriod='1'/>
```
<SetupInfo> Element (for TimeDataSource)

The <SetupInfo> element contains additional setup information for the <TimeDataSource> (see page 86) element.

**Attributes**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RowCount</td>
<td>'number' (of samples)</td>
</tr>
<tr>
<td>SamplePeriod</td>
<td>'number &quot;time_unit&quot; (in the online help)' (sampling period for the timing data)</td>
</tr>
<tr>
<td>TriggerIndex</td>
<td>'number' (zero-based)</td>
</tr>
</tbody>
</table>

**Parents**

This element can have the following parents: <TimeDataSource> (see page 86).

**Examples**

```xml
<SetupInfo RowCount='1048000' TriggerIndex='523999' SamplePeriod='500 ps '/>
```
<TimeDataSource> Element

The <TimeDataSource> element contains information about the external oscilloscope channel's time column in the binary data file.

<table>
<thead>
<tr>
<th>Attributes</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td></td>
<td>'Periodic'</td>
</tr>
</tbody>
</table>

| Children   | This element can have the following children: <SetupInfo> (for TimeDataSource) (see page 85). |

| Parents    | This element can have the following parents: <Channel1/2/3/4DataTable> (see page 65). |

| Examples   | <TimeDataSource Type='Periodic'>
          |   <SetupInfo RowCount='1048000' TriggerIndex='523999' SamplePeriod='500 ps'/>
          |   </TimeDataSource> |
<TriggerSetup> Element

The <TriggerSetup> element describes the external oscilloscope trigger options.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analyzer</td>
<td>'string' (name of logic analyzer module the oscilloscope is associated with)</td>
</tr>
<tr>
<td>AutoDeskew</td>
<td>'F' (false) or 'T' (true)</td>
</tr>
<tr>
<td>AutoDeskewExtIntTime</td>
<td>'floating_point_number' (the deskew time for the oscilloscope triggering the logic analyzer)</td>
</tr>
<tr>
<td>AutoDeskewIntExtTime</td>
<td>'floating_point_number' (the deskew time for the logic analyzer triggering the oscilloscope)</td>
</tr>
<tr>
<td>ManualDeskewExtIntTime</td>
<td>'floating_point_number' (the deskew time for the oscilloscope triggering the logic analyzer)</td>
</tr>
<tr>
<td>ManualDeskewIntExtTime</td>
<td>'floating_point_number' (the deskew time for the logic analyzer triggering the oscilloscope)</td>
</tr>
<tr>
<td>TriggerDirection</td>
<td>'LATrigScope' or 'ScopeTrigLA'</td>
</tr>
</tbody>
</table>

Parents

This element can have the following parents: "<Module>" (in the online help).

When used in COM automation, this element is returned by the "QueryCommand method" (in the online help)'s GetAllSetup query. You can also use this element string as an XMLCommand with the "DoCommands method" (in the online help) to configure the External Oscilloscope module.

Example

```xml
<TriggerSetup
    TriggerDirection='LATrigScope'
    AutoDeskew='T'
    Analyzer='My 1682D-1'
    AutoDeskewExtIntTime='9.996667e-008'
    AutoDeskewIntExtTime='-1.150000e-008'
    ManualDeskewExtIntTime='9.996667e-008'
    ManualDeskewIntExtTime='-1.150000e-008'
/>
```
<WaveformData> Element

The `<WaveformData>` element contains information about the data associated with the oscilloscope's digital channels.

**Children**
This element can have the following children: `<Pod1/2>` (see page 78).

**Parents**
This element can have the following parents: `<DigitalChannels>` (see page 71).

**Example**
```xml
<WaveformData>
  <Pod1 Valid='T' XInc='1.000000e-009' XOrg='-2.668490e-004'
   XRef='0' YInc='1.000000e+000' YOrg='0.000000e+000'
   YRef='0' MinVoltage='0.000000e+000'
   MaxVoltage='0.000000e+000' NumBytesPerSample='1'
   NumSamples='524300' />
  <Pod2 Valid='T' XInc='1.000000e-009' XOrg='-2.668490e-004'
   XRef='0' YInc='1.000000e+000' YOrg='0.000000e+000'
   YRef='0' MinVoltage='0.000000e+000'
   MaxVoltage='0.000000e+000' NumBytesPerSample='1'
   NumSamples='524300' />
</WaveformData>
```
Index

Numerics

10 MHz CLOCK IN input, 39

A

Add External Oscilloscope wizard, 13
AnalogDataSource element, 59
automatic trigger deskew, 43

B

buses, external oscilloscope, 42
BusSignal element, 60
BusSignals element, 61
BusSignalSetup element, 62

C
calibration procedure, 49
calibration procedure, external oscilloscope time correlation, 48
Channel1/2/3/4 element, 63
Channel1/2/3/4DataTable element, 65
Channels element, 66
channels, external oscilloscope, 42
ChannelsSetup, XML element (External Oscilloscope), 67
CLOCK IN input, 39
COM Automation, external oscilloscope, 55
concepts, external oscilloscope time correlation, 47
configuration files, external oscilloscope, 27
connection information, external oscilloscope, 13
connection, external oscilloscope, 44
ConnectionSetup, XML element (External Oscilloscope), 68

drift, correlation, 39

E

E5850A Time Correlation, 3
external oscilloscope data, displaying, 19
external oscilloscope IP address, 34
External Oscilloscope Setup dialog, 42
external oscilloscope setup options, 29
external oscilloscope setup, saving, 42
external oscilloscope time correlation and data display, 3
eexternal oscilloscope triggers logic analyzer, 43
external oscilloscope, connection information, 13
eexternal oscilloscope, deleting, 31
eexternal oscilloscope, split analyzer and, 13, 43
External Scope Web Control VbaView window, 23

F

Folder element, 74

G

g getting started, external oscilloscope time correlation and data display, 9

L

LAN problems, external oscilloscope, 35
limit import to N samples, external oscilloscope, 42
logic analyzer triggers external oscilloscope, 43

M

manual trigger deskew, 43
markers, external oscilloscope, 17
Markers, XML element (External Oscilloscope), 75
measurement, external oscilloscope, 16

N

Name element, 76
Names element, 77
network external oscilloscope and logic analyzer, 10
notices, 2

O

options, external oscilloscope, 42
oscilloscope (external) time correlation, 3
oscilloscope data, displaying, 19

P

Pod1/2 element, 78
point-to-point network set up, external oscilloscope, 10
point-to-point network set up, logic analyzer, 11
point-to-point network, external oscilloscope and logic analyzer, 10
Programming, XML element (External Oscilloscope), 79

R

reference, external oscilloscope, 41

S

SampleNumberDataSource element, 81
SetupInfo element, 82, 83, 84, 85
skew, external oscilloscope time correlation, 53
split analyzer, external oscilloscope and, 13, 43

T

TimeDataSource element, 86
trademarks, 2
tigger deskew, 43
tigger deskew, external oscilloscope time correlation, 48
tigger direction, 43
triggering problems, external oscilloscope, 36
TriggerSetup, XML element (External Oscilloscope), 87
troubleshooting, external oscilloscope, 33

U

uncertainty in external oscilloscope time correlation, 52

V

VbaView window, External Scope Web Control, 23
Index

View Scope, 3

W

waveform display, external oscilloscope, 3
WaveformData element, 88
web control, external oscilloscope, 23
wizard, Add External Oscilloscope, 13

X

XML format, external oscilloscope, 57